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Enhancements 

 Analysis & Design 3 

1) Plate Beam and Plate Column Design as per Eurocode 

2) Accelerating, breaking and centrifugal force in Moving Load (AASHTO and PENDDOT) 

3) Improvement on Traffic Lane Function 

4) Addition of Legal & Permit Load as per AASHTO LRFD 

5) Improvement of Moving load analysis as per Poland Standard 

6) Moving Load Optimization to Poland Standard 

7) Improvement on Steel Tub  torsional resistance 

8) Construction Stage Analysis considering material non-linearity 

9) Addition of artificial earthquake generation function of dynamic analysis 

10) Seismic analysis based on Base Line Correction when Multiple Support Excitation is applied 

11) Implementation of Australian Time Dependent Material property standard 

12) Implementation of Steel Girder Design as per IRC 24 - 2010 

 Pre & Post-Processing 

1) Revit 2018 interface 

2) Reinforcement data interchange between Civil and GSD 

3) Improvement on Bridge wizard function 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

1. Plate Beam and Plate Column (1D) Design Method 

 Plate elements can now be designed with the same method of designing conventional 1D elements such as Beam or Column as per Eurocode. 

 The plate design is performed for defined sub-domain. Member Type are chosen according to the purpose of the design. (e.g. Plate Beam (1D) : Slab Design and Plate 

Column (1D) :  Abutment / Sidewall Design).  

 Rebar Direction for the main rebar and distribution rebar can be defined using Local Coordinate System, UCS or Reference Axis. 

Define Domain Define Sub-Domain 

* Note : This feature is used for the calculation of Wood-Armer mom
ent of specific direction. This will be fixed to default for Plate Design 
(Dir.1 = 0 deg, Dir.2 = 90 deg). 

 Node/Element > Elements > Define Sub-Domain 

If Reference Axis is selected 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

1. Plate Beam and Plate Column (1D) Design Method 

 The results of plate design can be checked in table format and also both Graphic and Detail report can be outputted. 

 Positive/Negative Bending moment capacity, shear capacity and crack checks can be performed and the detail results can be obtained from this function. 

 From this version, the benefit of axial force in calculation of flexural strength can be considered by considering Axial-Moment Interaction (P-M Interaction) for plate 

column. The Axial-Moment Diagram can be obtained from the graphic result of plate column design and checking. 

Top and Bottom rebar data can be 
inputted separately for multiple locations. 

Rebar can be inputted using 
either Number or CTC method. 

The amount of rebar (As) 
is shown directly. 

Graphic Report Detail Report 

 Design > RC Design > Plate Beam/Column 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

1. Plate Beam and Plate Column (1D) Design Method 

 The results of plate design can be checked in table format and also both Graphic and Detail report can be outputted. 

 Positive/Negative Bending moment capacity, shear capacity and crack checks can be performed and the detail results can be obtained from this function. 

 From this version, the benefit of axial force in calculation of flexural strength can be considered by considering Axial-Moment Interaction (P-M Interaction) for plate 

column. The Axial-Moment Diagram can be obtained from the graphic result of plate column design and checking. 

Graphic Report 

 Design > RC Design > Plate Column Design/Checking 

Axial-Moment Interaction can be 
considered as an option 

Consideration of Axial-
Moment Interaction can be 
checked from Plate Column 
Design/Checking 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

2. Export Centrifugal, Acceleration & Braking forces (AASHTO LRFD and PennDOT) 

 It is possible to export centrifugal, acceleration & braking forces as different static load cases according to the AASHTO LRFD and PennDOT. 

 It is possible to import vertical centrifugal (C), longitudinal acceleration (AA) and Braking (BA) as different static load cases.   

 Results > Moving Load > Moving Tracer > Write Min/Max Load to File 
 Results > Moving Load > Batch Conversion from MVLTRC to Static Load 

Export dialog for acceleration, braking and centrifugal force 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

2. Export Centrifugal, Acceleration & Braking forces (AASHTO LRFD and PennDOT) 

 It is possible to export centrifugal, acceleration & braking forces as different static load cases according to the AASHTO LRFD and PennDOT. 

 It is possible to import vertical centrifugal (C), longitudinal acceleration (AA) and Braking (BA) as different static load cases.   

Acceleration & Braking 

 Results > Moving Load > Moving Tracer > Write Min/Max Load to File 
 Results > Moving Load > Batch Conversion from MVLTRC to Static Load 

The braking force shall be taken as the greater of: 
 
- 25 % of the axle weights of the design truck or tandem. 
- 5 % of the (design truck + lane load) or 5 % of the (design tandem + 

lane load). 
 
* The multiple presence factors shall apply. 
* Dynamic Load Allowance shall not be considered. 
* Direction of acceleration will be the same as vehicle moving direction 
and direction of braking will be the opposite. 

Centrifugal 

The centrifugal force shall be calculated as per AASHTO LRFD 3.6.3: 

𝑪 = 𝒇
𝒗𝟐

𝒈𝑹
 

where: 
v = highway design speed (ft/s) 
f = 4/3 for load combination other than fatigue and 1.0 for fatigue 
g = gravitational acceleration: 32.2 (ft/s^2) 
R = radius of curvature of traffic lane (ft) 
 
C value will be applied to the axle load to calculate centrifugal force. 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

3. Improvement on traffic lane function 

 Traffic Lane Optimization function has been changed to Transverse Lane Optimization. 

 Previously vehicle was positioned at the middle and both left and right ends within each traffic lane to find the worst transverse effect of the moving load. The vehicle 

will now be positioned at the middle and left and right ends within the allowable width specified below the Transverse Lane Optimization function. 

 

Previous version 

Vehicle was positioned in the multiple positions within the 
specified Lane width in the previous version. From midas Civil 
2018 v2.1, vehicle will be positioned at the middle and 
additionally left and right ends of specified ‘Allowable Width’ if 
Transverse Lane Optimization function is used. 

 Load > Moving Load > Traffic Line/Surface Lanes 

From midas Civil 2018 v2.1 

Allowable Width can be defined by checking on the Transverse 
Lane Optimization option and the default value of Allowable 
Width is taken from the Lane Width. 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

4. Addition of Legal & Permit Load as per AASHTO LRFD 

 Addition of Legal & Permit Load in the user defined vehicle option to consider the various conditions where the span of the structure is over or under 200ft. 

Addition of Legal/Permit Load as per AASHTO LRFD 

 Load > Moving Load > Vehicles (AASHTO LRFD) 

Legal Load 
Normal analysis result: 
A. Span length of all traffic lanes are under than 200ft : 

Concentrated Load 
B. If more than one traffic lane span is over 200ft : 

max/min[Concentrated Load, Concentrated Load x 
0.75 + UDL(0.2 kips/ft)] 
 

Negative moment and reaction at interior pier: 
A. Span length of all traffic lanes are under 200ft : 

max/min[Concentrated Load, two Concentrated Loads 
with 30ft spacing x 0.75 + UDL(0.2kips/ft)] 

B. If more than one traffic lane span is over 200ft : 
max/min[Concentrated Load, Concentrated Load x 
0.75 + UDL(0.2 kips/ft), two Concentrated Loads with 
30ft spacing x 0.75 + UDL(0.2kips/ft)] 
 

Permit Load 
Normal analysis result: Concentrated Load 
 
Negative moment and reaction at interior pier: 
A. Span length of all traffic lanes are under than 200ft : 

Concentrated Load 
B. If more than one traffic lane span is over 200ft : 

max/min[Concentrated Load, Concentrated Load x 
0.75 + UDL(0.2 kips/ft)] 

 
Impact factor is only applied to concentrated load and the 
span length is calculated based on span start check of 
traffic lane 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

5. Moving Load analysis improvement as per Poland Standard 

 In the previous versions, uniform distribution loads were included for Vehicle 2S  Now, uniform distribution loads  were excluded for Vehicle 2S 

 In the previous versions, concentrated forces for Vehicle K can be applied to more than 2 lanes  Now, concentrated forces for Vehicle K are applied only one critical 

lane. 

 In the previous versions, uniform distribution loads were calculated by wheel spacing  Now, uniform distribution loads are calculated by land width. 

 

 Load > Moving Load > Traffic Line/Surface Lane > Traffic Line Lanes 

 Load > Moving Load > Vehicles 

Previous version 

New version 

Previous version 

New version 

Previous version 

New version 

3. Improvement 2. Improvement 1. Improvement 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

6. Moving Load Optimization to Poland Standard 

 Load > Moving Load > Traffic Line/Surface Lane > Moving Load Optimization 

 Load > Moving Load > Moving Load Cases 

Traffic Line Lane Optimization Moving Load Case Road Bridge 

 In the previous versions, moving load analysis was used to find critical vehicle locations on bridges in the longitudinal direction. The critical locations of vehicles in the  

transverse direction were determined by the user based on their experiences or trial-and-error approach. 

 Now, Moving Load Optimization complements and extends the capabilities of moving load analysis and helps to significantly simplify the evaluation of critical vehicle 

locations. The critical locations of vehicles will be identified in the transverse direction as well as longitudinal direction according to the code provision. 

 It reduces the amount of time spent defining lanes and leads to more  economical design. 

  Other regional codes will be included in the next upgrades. 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

6. Moving Load Optimization to Poland Standard (continued) 

Lane 1 Lane 2 Lane 3 Lane 4 

Carriageway width = 16m 

Minimum vehicle distance = 1100 mm 

Centerline of carriageway 

 An example of Moving Load Optimization to find the worst position of vehicles for the leftmost side of carriageway 

Lane width = 3500 mm 

Wheel spacing = 1900 mm 
Margin = 550 mm 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

6. Moving Load Optimization to Poland Standard (continued) 

Centerline of carriageway 

1st centerline of vehicle 

2nd centerline to the left side 2nd centerline to the right side 

•  The program will generate the centerlines of vehicles in the transverse direction within the carriageway width. 
 
•  The spacing of the centerlines is defined by the user. (Anal. Lane Offset) 
 
•  The first centerline will be generated at the centerline of carriageway. 
 
•  The second centerline will be generated away from the first centerline by the value of "Anal. Lane Offset" to the both left and right side. 
 
•  More centerlines will be generated by the user-defined spacing within the carriageway. 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

6. Moving Load Optimization to Poland Standard (continued) 

1500 

Removed 

•  Vehicle centerlines which does not satisfy the requirement of minimum spacing between vehicle and boundary of carriageway and minimum s
pacing between vehicles will be removed from the vehicle application. 
 
•  For example, the three centerlines in the figure below will be removed from the vehicle application. 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

6. Moving Load Optimization to Poland Standard (continued) 

1. Select ‘Moving Load Optimization' function. 

 Required Steps 

2. Define Carriageway data. 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

6. Moving Load Optimization to Poland Standard (continued) 

3. Define vehicle. 4. Define Moving Load Case. 

Minimum distance between 
two vehicles in the transverse direction. 

Check on  
“Moving Load Optimization". 



17  

Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

7. Improvement on Steel Tub Torsional Resistance 
 Steel tub sections have very low inherent torsional resistance.  Hence, practically the top flanges of a steel tub are always connected via a bracing to increase this torsional 

resistance. 

 Ignoring this torsional resistance can lead to erroneous results in pre-composite stage, especially in cases where torsional rigidity plays important role.  Example of such cases 

would be bridges with skew and curvature, wherein the bearing reactions would be greatly altered. 

 General practice in such cases is to idealize this tub section as a box section, wherein the thickness of the top flange is calculated manually depending on the type and spacing of 

the bracings. 

 With the latest release in midas Civil, the user can now provide this equivalent flange thickness for steel tub composite section.  This thickness would only increase the torsional 

resistance of the steel tub in the pre-composite stage only. 

 
 Properties > Section> Section Properties> Composite> Steel-Tub (Type 1)/(Type 2) 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

8. Construction Stage Analysis considering Material Nonlinearity 

 Construction stage analysis with material nonlinear is supported. 

 Plastic model for material can be defined in dialog box of ‘Plastic Material’ and ‘Material Data’ 

  Step 1. Define Plastic Material Data   Step 2. Define Material Nonlinear   Step 3. Define Construction stage analysis Option 

Setting for Construction Stage Analysis with Material nonlinear 

Linear Model  

(Max. for sig_eff =2.5N/mm2) 

Material nonlinear Model  

(Max. for sig_eff =5.4N/mm2) 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

9. Addition of artificial earthquake generation function of dynamic analysis 

 Spectral load and time history load used for dynamic analysis (Response Spectrum Analysis and Time History Analysis) can be generated as artificial seismic waves. 

 It is possible to apply dynamic load with various variables through artificial earthquake generation referring to Design Spectrum according to country code. 

 Tools > Data Generator > Artificial Earthquake  
 

Design Spectrum 



20  

Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

 Load > Dynamic Loads > Multiple Support Excitation 

10. Seismic analysis based on Base Line Correction when Multiple Support Excitation is applied 

 Added the function to correct each point acceleration according to the base line which is the standard of acceleration loading with multi points. 

 Displacement convergence over time using Base Line Correction method. 

Base Line Correction Explanation 

Result before Base Line Correction 

Result after Base Line Correction 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

 Properties > Time Dependent Material > Creep/Shrinkage 

11. Time Dependent Materials as per Australian Standard (AS 5100.5 – 2017) 

 Time dependent material properties: Updated Creep and Shrinkage can be defined as per AS 5100.5 – 2017. 

 

Creep/Shrinkage definition dialog box 

Creep Coefficient 

hte
008.0

2 12.10.1




AS 5100.5 - 2016 
hte

005.0

2 12.18.0




AS 5100.5 - 2017 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

 Properties > Time Dependent Material > Comp. Strength 

11. Time Dependent Materials as per Australian Standard (AS 5100.5 – 2017) 

 Time dependent material properties: Updated Concrete Compressive Strength can be defined as per AS 5100.5 – 2017. 

Comp. Strength definition dialog box 

AS 5100.5 - 2016 

AS 5100.5 - 2017 
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Civil  2018 (v2.1) Release Note Civil 2018 Analysis & Design 

 Design > Steel Design > IRC 24 -2010  

12. Implementation of Steel Girder Design as per IRC 24 -2010 

 Design steel sections using IRC 24 -2010. Data base sections Angle, Channel, I, H, Box and Steel plate design are supported. 

 Structural steel materials as per IS  2062 -2011. 

 Graphic report and Detailed Text  report for Bending Resistance, Shear Resistance, Lateral Torsional Buckling and Combined forced could be generated. 

Steel Design Code  Text Report  Graphic Report  
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Civil  2018 (v2.1) Release Note Civil 2018 Pre & Post-Processing 

1. Revit 2018 interface 

 Using Midas Link for Revit Structure, direct data transfer between midas Civil and Revit 2018 is available for Building Information Modeling (BIM) workflow. Midas 

Link for Revit Structure enables us to directly transfer a Revit model data to midas Civil, and deliver it back to the Revit model file. This feature is provided as an Add-

In module in Revit Structure and midas Civil text file (*.mct) is used for the roundtrip. 

 File > Import > midas Civil MCT File 

 File > Export > midas Civil MCT File 

  Functions Revit <> Gen 

Linear  

Elements 

 Structural Column   <> 

 Beam   <> 

 Brace   <> 

 Curved Beam   > 

 Beam System   > 

 Truss   > 

Planar 

 Elements 

 Foundation Slab   <> 

 Structural Floor   <> 

 Structural Wall   <> 

 Wall Opening & Window   > 

 Door   > 

 Vertical or Shaft Opening   > 

Boundary 

 Offset   > 

 Rigid Link   > 

 Cross-Section Rotation   > 

 End Release   > 

 Isolated Foundation Support   > 

 Point Boundary Condition   > 

 Line Boundary Condition   > 

 Wall Foundation   > 

 Area Boundary Condition   > 

Load 

 Load Nature   > 

 Load Case   > 

 Load Combination   > 

 Hosted Point Load   > 

 Hosted Line Load   > 

 Hosted Area Load   > 

Other  

Parameters 

 Material   <> 

 Level > 

Send Model to midas Civil 

Revit 2018 Civil 2018 
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Civil  2018 (v2.1) Release Note Civil 2018 Pre & Post-Processing 

2. Reinforcement data interchange between Civil and GSD 

 Addition of the function to link rebar input data to Civil column with GSD. 

 Improvement of GSD design process (Interaction Curve and Moment Curvature Curve) through convenient reinforcement input function of Civil.  

 The process of creating reinforcing bars in Line and Arc Type for track type and arbitrary cross section in GSD can be conveniently placed using  Rebar Input function 

in Civil. 

 Design > RC Design > Beam Section Data for Checking 
 Design > RC Design > Column Section Data for Checking 
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Civil  2018 (v2.1) Release Note Civil 2018 Pre & Post-Processing 

3. Improvement on Steel/Prestressed Composite Bridge Wizard 

 Form work load can now also consider S.I.P forms (Stay in place forms). If S.I.P forms is selected, the loading on the girder will be activated after the composite action 

as well. 

 Loading data across the girders can now be distributed equally using ‘Equally to All Girder’ option. 

 Structure > Wizard > Steel/Prestressed Composite Bridge wizards 

Changes in Load tab of Steel/Prestressed Composite Bridge Wizard 

Example of 1.5” Form Deck (Stay in Place forms) 

Applying ‘Equally to All Girder’ function 
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3. Improvement on Steel/Prestressed Composite Bridge Wizard 

 Multi-curve was inputted by entering the coordinate data of the steel/prestressed composite girder. New input option is implemented in the case where there is no 

coordinate data for the curvature of the structure. This is the same multi-curve input method of that of the Grillage Model Wizard. 

Changes in Layout tab of Steel/Prestressed Composite Bridge Wizard 

 Structure > Wizard > Steel/Prestressed Composite Bridge wizards 

Curve Data input 

Coordinate Data input 


